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Chapter 1
1. Introduction to iPad iOS 5 Development
Essentials

O

n August 18, 2011 Hewlett Packard announced plans to overhaul its entire business strategy and begin
steps to exit the PC business. This announcement was not entirely unexpected, especially given the
continued decline in margins for PCs and laptops combined with the erosion of sales growth caused by the
popularity of smartphones and tablets.
Although HP ultimately decided to remain in the PC business, the truly surprising announcement that day
was that HP would also be discontinuing the WebOS based TouchPad tablet and Pre smartphone range. This
announcement was surprising in part because less that 12 months had passed since HP paid $1.2 billion to
buy Palm, Inc. in order to acquire the Pre smartphone and WebOS platforms. The issue that most startled the
media and industry, however, was the fact that the TouchPad had at this point only been on the market for a
mere six weeks.
Whilst a number of factors will have contributed to HP’s exit from the tablet marketplace, the overriding
factor was most likely that, in spite of a marketing budget rumored to be in excess of $150 million, the device
simply could not compete with the iPad.
In early 2011 Gartner, a respected technology analysis and research company predicted that sales growth for
personal computers would fall from 15.9% growth down to a much lower 10.5%. In September 2011 Gartner
announced that previous estimates were proving to be overly optimistic and predicted that the year would
see a global PC market growth rate of a mere 3.8%. This predicted decline in PC sales growth has been largely
attributed to the surge in popularity of tablet based computers.
The concept of a tablet computer is, of course, nothing new. After all, Bill Gates demonstrated a Windows
based tablet PC at the Comdex trade show in Las Vegas as far back as 2001. The single event that triggered
this market shift was the introduction of the iPad in April 2010. Within the first year Apple sold 15 million first
generation iPad units. The iPad 2 launched in March 2011 and was sold out within the first weekend of sales
in each of the countries in which it was marketed. Total sales are now believed to have exceeded 20 million
units with approximately 8 million new units shipping every quarter.
When developing for the iPad it is important to understand that you are not just targeting a hardware device.
In essence you are leveraging an entire ecosystem consisting of the device hardware, the iOS operating
system, software development kit (SDK), iTunes platform and, perhaps most importantly, the App Store. No
longer is the success of a mobile device platform a matter of simply the operating system and hardware.
Instead, a platform will succeed or fail based on the ecosystem to which it belongs. Google’s understanding
of the importance of the applications market, for example, has contributed significantly to the success of
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Android based devices. Conversely Nokia’s failure to create a successful ecosystem was cited by CEO Stephen
Elop as a contributing factor to the demise of the Symbian operating system and the company’s move to
Microsoft’s Windows Phone platform for future Nokia smartphones.
It is also important to understand that most, if not all, the skills you learn developing iOS 5 applications for
the iPad also apply to iPhone application development (a market consisting of over 160 million iPhone
owners, each a potential customer).
The aim of this book is to teach you the skills necessary to build your own apps for the iPad. Beginning with
the basics, this book provides an overview of the iPad hardware and the architecture of iOS 5. An
introduction to programming in Objective-C is provided followed by an in-depth look at the design of iPad
applications and user interfaces. More advanced topics such as file handling, database management, graphics
drawing and animation are also covered, as are touch screen handling, gesture recognition, multitasking, iAds
integration, location management, local notifications, maps, split views, camera access and video playback
support.
New iOS 5 specific features are also covered in detail including page view controller implementation, the
UIDocument class, iCloud based storage, Storyboard user interface design, automatic reference counting,
Twitter integration and image filtering with Core Image.
iPad iOS 5 Development Essentials takes a modular approach to the subject of iPad application development
with each chapter covering a self contained topic area. This makes the book both an easy to follow learning
aid and an excellent reference resource.

1.1 Example Source Code
The source code and Xcode project files for the examples contained in this book are available for download at
http://www.ebookfrenzy.com/code/ipadios5.zip.

1.2 Feedback
We want you to be satisfied with your purchase of this book. If you have any comments, questions or
concerns please contact us at feedback@ebookfrenzy.com.
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Chapter 2
2. The History of iOS

W

hen Objective-C 2.0 Essentials (a companion book to iPad iOS 5 Development Essentials) was
published in 2010 one of the most popular chapters was, rather surprisingly, one entitled “The History
of Objective-C”. Since much of the history of Objective-C also applies to iOS it seemed to make sense to
adapt the original Objective-C chapter to also tell the history of iOS.
In the 1970s Steve Jobs and Steve Wozniak founded Apple Computer. After many years of success, Steve Jobs
hired a marketing wizard from PepsiCo named John Sculley to help take Apple to the next level of business
success. To cut a long story short, a boardroom battle ensued and Steve Jobs got pushed out of the company
(for the long version of the story pick up a used copy of John Sculley's book Odyssey: From Pepsi to Apple)
leaving John Sculley in charge.
After leaving Apple Jobs started a new company, which he named NeXT, to design an entirely new generation
of computer systems. The operating system developed by NeXT to run on these computers was called
NeXTStep and was based on the Mach kernel developed at Carnegie Mellon University and the Berkeley
Standard Distribution (BSD) system developed at the University of California, Berkeley which, in turn, was
based on the UNIX operating system. As it became clear that the NeXT hardware was a commercial failure,
NeXT subsequently joined forces with Sun Microsystems to create a standardized version of NeXTStep named
OPENstep which the Free Software Foundation then adopted as GNUstep.
During the 1990s, John Sculley left Apple and a procession of new CEOs came and went. During this time,
Apple had been losing market share and struggling to come out with a new operating system to replace the
aging Mac OS. After a number of failed attempts and partnerships, it was eventually decided that rather than
try to write a new operating system, Apple should acquire a company that already had one. During Gil
Amelio's brief reign as CEO, a shortlist of two companies was drawn up. One was a company called Be, Inc.
founded by a former Apple employee named Jean-Louis Gassée, and the other was NeXT.
Ultimately, NeXT was selected and Steve Jobs once again joined Apple. In another boardroom struggle
(another long story as outlined in Gil Amelio's book On the Firing Line: My 500 Days at Apple) Steve Jobs
pushed out Gil Amelio and once again became CEO of the company he had founded all those years ago.
The rest, as they say, is history. NeXTStep formed much of the foundation for the operating system that
became Mac OS X. Mac OS X was subsequently modified to provide the operating system for the
spectacularly successful iPhone. What was then called iPhone OS was later renamed iOS to coincide with the
introduction of the iPad.
Although there is little obvious evidence of the history of iOS in the SDK there is one constant reminder for
those aware of the operating system’s origins. Whilst working through this book you will encounter a number
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of Foundation Framework class names that begin the letters “NS” such as NSArray and NSString. The letters
“NS” refer, of course, to the ‘N’ and ‘S’ in NeXTStep.
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Chapter 3
3. The Anatomy of an iPad 2

T

he majority of coding that is involved in developing applications for the iPad consists of interacting with
and responding to the device hardware in a variety of ways. Given this fact it is worth taking some time
to look at the underlying hardware contained in the shell of an iPad. The focus of this overview will be the
iPad 2 since this is the currently shipping device at the time of writing.

3.1 Display
The iPad 2 has a 9.7 inch display with a resolution of 1024 x 768 pixels capable of displaying 132 pixels per
inch (ppi). When the status bar is displayed (the bar containing the time, battery level and signal strength) the
usable screen space is 1024x748 in landscape and 768x1004 in portrait mode.
The underlying technology is an In Plane Switching (IPS) LED, capacitive multi touch screen. The screen has a
scratch, oil and fingerprint resistant oleophobic coated surface. The device also has ambient light detection
that adjusts the screen brightness to ensure the optimal screen visibility in a variety of lighting conditions
from bright sunlight to darkness.

3.2 Wireless Connectivity
The iPad 2 supports a wide range of connectivity options. When within range of a Wi-Fi network, the device
can connect at either 802.11b, 802.11g or 802.11n speeds.
For models with cellular support, the AT&T device supports GSM/EDGE connectivity (otherwise known as
2G). For faster speeds, support is also provided for connectivity via Universal Mobile Telecommunications
System (UMTS), High-Speed Downlink Packet Access (HSDPA) and High Speed Uplink Packet Access (HSUPA).
This is better known as 3G and provides data transfer speeds of up to 7.2 megabits per second. The Verizon
model supports CDMA EV-DO Rev. A.
The iPad 2 also includes Bluetooth v2.1 support with Enhanced Data Rate (EDR) technology.

3.3 Wired Connectivity
Given the wide array of wireless options it is not surprising that the iPad has little need for wired
connections. In fact the iPad only has two. One is a standard 3.5 mm headset jack for the attachment of
headphones or other audio devices. The second is a proprietary, 30-pin dock connector that, by default, is
used to provide a USB connection for synching with a computer system and battery charging. In practice,
however, this connection also provides audio and TV output via specialty third party cables.
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3.4 Memory
The iPad 2 comes in six configurations divided into Wi-Fi only and Wi-Fi + 3G categories. Each category of
device is available in 16GB, 32GB and 64GB versions. The memory is in the form of a flash drive. Unlike some
devices, the iPad lacks the ability to supplement the installed memory by inserting additional flash memory
cards.

3.5 Cameras
The iPad 2 contains both front and rear facing cameras. The rear camera is capable of recording video at a
resolution of 720p and at a rate of 30 frames per second and can also act as a still camera with 5x digital
zoom.
The front facing camera is VGA resolution also at 30 fps.

3.6 Sensors
Sensors built into the iPad 2 consist of an accelerometer that uses the pull of gravity to detect when the
device is moved or rotated, a three-axis gyroscope and an ambient light sensor that detects current
environmental light levels.

3.7 Location Detection
All iPad 2 models contain a digital compass and the ability to identify approximate location information using
Wi-Fi. The Wi-Fi + 3G models, however, also support location detection via GPS support with Assisted GPS (AGPS) support. Essentially this enables the iPad to identify the current location by detecting radio signals from
GPS satellites.

3.8 Central Processing Unit (CPU)
The central processing unit (CPU) of the iPad 2 is the Apple A5, an Apple designed 1Ghz dual core system-ona-chip (SoC) consisting of an ARM Cortex A9 MPCore chip combined with an Imagination Technologies
PowerVR Graphics Processing Unit (GPU). This Cortex A9 MPCore processor is designed by ARM Holdings, a
British company that specializes in designing chips and then licensing those designs to third parties who then
manufacture them. This differs considerably from the approach taken by companies such as Intel who both
design and manufacture their own chips.
The Cortex A9 chip is based on the ARMv7 processor architecture and instruction set and was chosen by
Apple for its combination of high performance and low power requirements.

3.9 Graphics Processing Unit (GPU)
As previously mentioned, iPad 2 graphics are handled by an Imagination Technologies PowerVR Graphics
Processing Unit (GPU), specifically the PowerVR SGX 543MP2. This provides support for OpenGL ES 1.1/2.0 (a
lightweight version of SGI’s OpenGL platform), OpenGL 2.0/3.0 and OpenVG 1.1 and DirectX 9/10.1 graphics
drawing and manipulation and includes the Universal Scalable Shader Engine (USSE), all key requirements for
graphics intensive games development.
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3.10 Speaker and Microphone
The iPad 2 includes both a built-in microphone and a speaker. Both the speaker and microphone may be used
by third party apps.

3.11 Battery
The iPad 2 contains lithium-polymer battery rated at 25 watt hours and estimated to provide 9 - 10 hours of
typical use including video or audio playback or Wi-Fi internet access.

3.12 Summary
As we have seen in this chapter, the iPad 2 packs an impressive amount of technology into a case that is 9.5
inches high, 7.31 inches wide, 0.34 inches deep weighing in at 1.33 lbs. Perhaps the most exciting aspect of all
this technology is that you can, almost without exception, access and utilize all this hardware within your
own applications.
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Chapter 4
4. iOS 5 Architecture and SDK
Frameworks

I

n The Anatomy of an iPad 2 we looked at the hardware contained within an iPad 2 device. When we
develop apps for the iPad, Apple does not allow us direct access to any of this hardware. In fact, all
hardware interaction takes place exclusively through a number of different layers of software which act as
intermediaries between the application code and device hardware. These layers make up what is known as
an operating system. In the case of the iPad, this operating system is known as iOS.
In order to gain a better understanding of the iPad development environment, this chapter will look in detail
at the different layers that comprise the iOS 5 operating system and the frameworks that allow us, as
developers, to write iPad applications.

4.1 iPhone OS becomes iOS
Prior to the release of the iPad in 2010, the operating system running on the iPhone was generally referred to
as iPhone OS. Given that the operating system used for the iPad is essentially the same as that on the iPhone
it didn’t make much sense to name it iPad OS. Instead, Apple decided to adopt a more generic and nondevice specific name for the operating system. Given Apple’s predilection for names prefixed with the letter
‘i’ (iTunes, iBookstore, iMac etc) the logical choice was, of course, iOS. Unfortunately, iOS is also the name
used by Cisco for the operating system on its routers (Apple, it seems, also has a predilection for ignoring
trademarks). When performing an internet search for iOS, therefore, be prepared to see large numbers of
results for Cisco’s iOS which have absolutely nothing to do with Apple’s iOS.

4.2 An Overview of the iOS 5 Architecture
As previously mentioned, iOS consists of a number of different software layers, each of which provides
programming frameworks for the development of applications that run on top of the underlying hardware.
These operating system layers can be presented diagrammatically as illustrated in Figure 4-1:
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Figure 4-1

Some diagrams designed to graphically depict the iOS software stack show an additional box positioned
above the Cocoa Touch layer to indicate the applications running on the device. In the above diagram we
have not done so since this would suggest that the only interface available to the app is Cocoa Touch. In
practice, an app can directly call down any of the layers of the stack to perform tasks on the physical device.
That said, however, each operating system layer provides an increasing level of abstraction away from the
complexity of working with the hardware. As an iOS developer you should, therefore, always look for
solutions to your programming goals in the frameworks located in the higher level iOS layers before resorting
to writing code that reaches down to the lower level layers. In general, the higher level of layer you program
to, the less effort and fewer lines of code you will have to write to achieve your objective. And as any veteran
programmer will tell you, the less code you have to write the less opportunity you have to introduce bugs.
Now that we have identified the various layers that comprise iOS 5 we can now look in more detail at the
services provided by each layer and the corresponding frameworks that make those services available to us
as application developers.

4.3 The Cocoa Touch Layer
The Cocoa Touch layer sits at the top of the iOS stack and contains the frameworks that are most commonly
used by iPad application developers. Cocoa Touch is primarily written in Objective-C, is based on the standard
Mac OS X Cocoa API (as found on Apple desktop and laptop computers) and has been extended and modified
to meet the needs of the iPad hardware.
The Cocoa Touch layer provides the following frameworks for iPad app development:
4.3.1 UIKit Framework (UIKit.framework)
The UIKit framework is a vast and feature rich Objective-C based programming interface. It is, without
question, the framework with which you will spend most of your time working. Entire books could, and
probably will, be written about the UIKit framework alone. Some of the key features of UIKit are as follows:
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Application lifecycle management



Application event handling (e.g. touch screen user interaction)



Multitasking



Wireless Printing



Data protection via encryption



Cut, copy, and paste functionality



Web and text content presentation and management



Data handling



Inter-application integration



Push notification in conjunction with Push Notification Service



Local notifications (a mechanism whereby an application running in the background can gain the user’s
attention)



Accessibility



Accelerometer, battery, proximity sensor, camera and photo library interaction



Touch screen gesture recognition



File sharing (the ability to make application files stored on the device available via iTunes)



Blue tooth based peer to peer connectivity between devices



Connection to external displays

To get a feel for the richness of this framework it is worth spending some time browsing Apple’s UIKit
reference material which is available online at:
http://developer.apple.com/library/ios/#documentation/UIKit/Reference/UIKit_Framework/index.html
4.3.2 Map Kit Framework (MapKit.framework)
If you have spent any appreciable time with an iPad then the chances are you have needed to use the Maps
application more than once, either to get a map of a specific area or to generate driving directions to get you
to your intended destination. The Map Kit framework provides a programming interface which enables you
to build map based capabilities into your own applications. This allows you to, amongst other things, display
scrollable maps for any location, display the map corresponding to the current geographical location of the
device and annotate the map in a variety of ways.
4.3.3 Push Notification Service
The Push Notification Service allows applications to notify users of an event even when the application is not
currently running on the device. Since the introduction of this service it has most commonly been used by
news based applications. Typically when there is breaking news the service will generate a message on the
device with the news headline and provide the user the option to load the corresponding news app to read
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more details. This alert is typically accompanied by an audio alert and vibration of the device. This feature
should be used sparingly to avoid annoying the user with frequent interruptions.
4.3.4 Message UI Framework (MessageUI.framework)
The Message UI framework provides everything you need to allow users to compose and send email
messages from within your application. In fact, the framework even provides the user interface elements
through which the user enters the email addressing information and message content. Alternatively, this
information may be pre-defined within your application and then displayed for the user to edit and approve
prior to sending.
4.3.5 Address Book UI Framework (AddressUI.framework)
Given that a key function of the iPad is as a communications device and digital assistant it should not come as
too much of a surprise that an entire framework is dedicated to the integration of the address book data into
your own applications. The primary purpose of the framework is to enable you to access, display, edit and
enter contact information from the iPad address book from within your own application.
4.3.6 Game Kit Framework (GameKit.framework)
The Game Kit framework provides peer-to-peer connectivity and voice communication between multiple
devices and users allowing those running the same app to interact. When this feature was first introduced it
was anticipated by Apple that it would primarily be used in multi-player games (hence the choice of name)
but the possible applications for this feature clearly extend far beyond games development.
4.3.7 iAd Framework (iAd.framework)
The purpose of the iAd Framework is to allow developers to include banner advertising within their
applications. All advertisements are served by Apple’s own ad service.
4.3.8 Event Kit UI Framework
The Event Kit UI framework was introduced in iOS 4 and is provided to allow the calendar events to be
accessed and edited from within an application.
4.3.9 Accounts Framework (Accounts.framework)
iOS 5 introduces the concept of system accounts. These essentially allow the account information for other
services to be stored on the iOS device and accessed from within application code. Currently system accounts
are limited to Twitter accounts, though other services such as Facebook will likely appear in future iOS
releases. The purpose of the Accounts Framework is to provide an API allowing applications to access and
manage these system accounts.
4.3.10 Twitter Framework (Twitter.framework)
The Twitter Framework allows Twitter integration to be added to applications. The framework operates in
conjunction the Accounts Framework to gain access to the user’s Twitter account information.
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4.4 The iOS Media Layer
The role of the Media layer is to provide iOS with audio, video, animation and graphics capabilities. As with
the other layers comprising the iOS stack, the Media layer comprises a number of frameworks which may be
utilized when developing iPad apps. In this section we will look at each one in turn.
4.4.1 Core Video Framework (CoreVideo.framework)
The Core Video Framework provides buffering support for the Core Media framework. Whilst this may be
utilized by application developers it is typically not necessary to use this framework.
4.4.2 Core Text Framework (CoreText.framework)
The iOS Core Text framework is a C-based API designed to ease the handling of advanced text layout and font
rendering requirements.
4.4.3 Image I/O Framework (ImageIO.framework)
The Image I/O framework, the purpose of which is to facilitate the importing and exporting of image data and
image metadata, was introduced in iOS 4. The framework supports a wide range of image formats including
PNG, JPEG, TIFF and GIF.
4.4.4 Assets Library Framework (AssetsLibrary.framework)
The Assets Library provides a mechanism for locating and retrieving video and photo files located on the iPad
device. In addition to accessing existing images and videos, this framework also allows new photos and
videos to be saved to the standard device photo album.
4.4.5 Core Graphics Framework (CoreGraphics.framework)
The iOS Core Graphics Framework (otherwise known as the Quartz 2D API) provides a lightweight two
dimensional rendering engine. Features of this framework include PDF document creation and presentation,
vector based drawing, transparent layers, path based drawing, anti-aliased rendering, color manipulation and
management, image rendering and gradients. Those familiar with the Quartz 2D API running on MacOS X will
be pleased to learn that the implementation of this API is the same on iOS.
4.4.6 Core Image Framework (CoreImage.framework)
A new framework introduced with iOS 5 providing a set of video and image filtering and manipulation
capabilities for application developers.
4.4.7 Quartz Core Framework (QuartzCore.framework)
The purpose of the Quartz Core framework is to provide animation capabilities on the iPad. It provides the
foundation for the majority of the visual effects and animation used by the UIKit framework and provides an
Objective-C based programming interface for creation of specialized animation within iPad apps.
4.4.8 OpenGL ES framework (OpenGLES.framework)
For many years the industry standard for high performance 2D and 3D graphics drawing has been OpenGL.
Originally developed by the now defunct Silicon Graphics, Inc (SGI) during the 1990s in the form of GL, the
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open version of this technology (OpenGL) is now under the care of a non-profit consortium comprising a
number of major companies including Apple, Inc., Intel, Motorola and ARM Holdings.
OpenGL for Embedded Systems (ES) is a lightweight version of the full OpenGL specification designed
specifically for smaller devices such as the iPad.
iOS 3 or later supports both OpenGL ES 1.1 and 2.0 on certain iPhone models (such as the iPhone 3GS and
iPhone 4). Earlier versions of iOS and older device models support only OpenGL ES version 1.1.
4.4.9 GLKit Framework (GLKit.framework)
The GLKit framework is an Objective-C based API designed to ease the task of creating OpenGL ES based
applications.
4.4.10 NewsstandKit Framework (NewsstandKit.framework)
The Newsstand application is a new feature of iOS 5 and is intended as a central location for users to gain
access to newspapers and magazines. The NewsstandKit framework allows for the development of
applications that utilize this new service.

4.5 iOS Audio Support
iOS is capable of supporting audio in AAC, Apple Lossless (ALAC), A-law, IMA/ADPCM, Linear PCM, µ-law,
DVI/Intel IMA ADPCM, Microsoft GSM 6.10 and AES3-2003 formats through the support provided by the
following frameworks.
4.5.1 AV Foundation framework (AVFoundation.framework)
An Objective-C based framework designed to allow the playback, recording and management of audio
content.
4.5.2 Core Audio Frameworks (CoreAudio.framework, AudioToolbox.framework and
AudioUnit.framework)
The frameworks that comprise Core Audio for iOS define supported audio types, playback and recording of
audio files and streams and also provide access to the device’s built-in audio processing units.
4.5.3 Open Audio Library (OpenAL)
OpenAL is a cross platform technology used to provide high-quality, 3D audio effects (also referred to as
positional audio). Positional audio may be used in a variety of applications though is typically used to provide
sound effects in games.
4.5.4 Media Player Framework (MediaPlayer.framework)
The iOS Media Player framework is able to play video in .mov, .mp4, .m4v, and .3gp formats at a variety of
compression standards, resolutions and frame rates.
4.5.5 Core Midi Framework (CoreMIDI.framework)
Introduced in iOS 4, the Core MIDI framework provides an API for applications to interact with MIDI
compliant devices such as synthesizers and keyboards via the iPad’s dock connector.
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4.6 The iOS Core Services Layer
The iOS Core Services layer provides much of the foundation on which the previously referenced layers are
built and consists of the following frameworks.
4.6.1 Address Book Framework (AddressBook.framework)
The Address Book framework provides programmatic access to the iPad Address Book contact database
allowing applications to retrieve and modify contact entries.
4.6.2 CFNetwork Framework (CFNetwork.framework)
The CFNetwork framework provides a C-based interface to the TCP/IP networking protocol stack and low
level access to BSD sockets. This enables application code to be written that works with HTTP, FTP and
Domain Name servers and to establish secure and encrypted connections using Secure Sockets Layer (SSL) or
Transport Layer Security (TLS).
4.6.3 Core Data Framework (CoreData.framework)
This framework is provided to ease the creation of data modeling and storage in Model-View-Controller
(MVC) based applications. Use of the Core Data framework significantly reduces the amount of code that
needs to be written to perform common tasks when working with structured data within an application.
4.6.4 Core Foundation Framework (CoreFoundation.framework)
The Core Foundation framework is a C-based Framework which provides basic functionality such as data
types, string manipulation, raw block data management, URL manipulation, threads and run loops, date and
times, basic XML manipulation and port and socket communication. Additional XML capabilities beyond
those included with this framework are provided via the libXML2 library. Though this is a C-based interface,
most of the capabilities of the Core Foundation framework are also available with Objective-C wrappers via
the Foundation Framework.
4.6.5 Core Media Framework (CoreMedia.framework)
The Core Media framework is the lower level foundation upon which the AV Foundation layer is built. Whilst
most audio and video tasks can, and indeed should, be performed using the higher level AV Foundation
framework, access is also provided for situations where lower level control is required by the iOS application
developer.
4.6.6 Core Telephony Framework (CoreTelephony.framework)
The iOS Core Telephony framework is provided to allow applications to interrogate the device for information
about the current cell phone service provider and to receive notification of telephony related events.
4.6.7 EventKit Framework (EventKit.framework)
An API designed to provide applications with access to the calendar and alarms on the device.
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4.6.8 Foundation Framework (Foundation.framework)
The Foundation framework is the standard Objective-C framework that will be familiar to those who have
programmed in Objective-C on other platforms (most likely Mac OS X). Essentially, this consists of Objective-C
wrappers around much of the C-based Core Foundation Framework.
4.6.9 Core Location Framework (CoreLocation.framework)
The Core Location framework allows you to obtain the current geographical location of the device (latitude,
longitude and altitude) and compass readings from with your own applications. The method used by the
device to provide coordinates will depend on the data available at the time the information is requested and
the hardware support provided by the particular iPad model on which the app is running. This will either be
based on GPS readings, Wi-Fi network data or cell tower triangulation (or some combination of the three).
4.6.10 Mobile Core Services Framework (MobileCoreServices.framework)
The iOS Mobile Core Services framework provides the foundation for Apple’s Uniform Type Identifiers (UTI)
mechanism, a system for specifying and identifying data types. A vast range of predefined identifiers have
been defined by Apple including such diverse data types as text, RTF, HTML, JavaScript, PowerPoint .ppt files,
PhotoShop images and MP3 files.
4.6.11 Store Kit Framework (StoreKit.framework)
The purpose of the Store Kit framework is to facilitate commerce transactions between your application and
the Apple App Store. Prior to version 3.0 of iOS, it was only possible to charge a customer for an app at the
point that they purchased it from the App Store. iOS 3.0 introduced the concept of the “in app purchase”
whereby the user can be given the option to make additional payments from within the application. This
might, for example, involve implementing a subscription model for an application, purchasing additional
functionality or even buying a faster car for you to drive in a racing game.
4.6.12 SQLite library
Allows for a lightweight, SQL based database to be created and manipulated from within your iPad
application.
4.6.13 System Configuration Framework (SystemConfiguration.framework)
The System Configuration framework allows applications to access the network configuration settings of the
device to establish information about the “reachability” of the device (for example whether Wi-Fi or cell
connectivity is active and whether and how traffic can be routed to a server).
4.6.14 Quick Look Framework (QuickLook.framework)
The Quick Look framework provides a useful mechanism for displaying previews of the contents of file types
loaded onto the device (typically via an internet or network connection) for which the application does not
already provide support. File format types supported by this framework include iWork, Microsoft Office
document, Rich Text Format, Adobe PDF, Image files, public.text files and comma separated (CSV).
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4.7 The iOS Core OS Layer
The Core OS Layer occupies the bottom position of the iOS stack and, as such, sits directly on top of the
device hardware. The layer provides a variety of services including low level networking, access to external
accessories and the usual fundamental operating system services such as memory management, file system
handling and threads.
4.7.1 Accelerate Framework (Accelerate.framework)
The Accelerate Framework provides a hardware optimized C-based API for performing complex and large
number math, vector, digital signal processing (DSP) and image processing tasks and calculations.
4.7.2 External Accessory Framework (ExternalAccessory.framework)
Provides the ability to interrogate and communicate with external accessories connected physically to the
iPad via the 30-pin dock connector or wirelessly via Bluetooth.
4.7.3 Security Framework (Security.framework)
The iOS Security framework provides all the security interfaces you would expect to find on a device that can
connect to external networks including certificates, public and private keys, trust policies, keychains,
encryption, digests and Hash-based Message Authentication Code (HMAC).
4.7.4 System (LibSystem)
As we have previously mentioned, iOS is built upon a UNIX-like foundation. The System component of the
Core OS Layer provides much the same functionality as any other UNIX like operating system. This layer
includes the operating system kernel (based on the Mach kernel developed by Carnegie Mellon University)
and device drivers. The kernel is the foundation on which the entire iOS platform is built and provides the low
level interface to the underlying hardware. Amongst other things, the kernel is responsible for memory
allocation, process lifecycle management, input/output, inter-process communication, thread management,
low level networking, file system access and thread management.
As an app developer your access to the System interfaces is restricted for security and stability reasons.
Those interfaces that are available to you are contained in a C-based library called LibSystem. As with all
other layers of the iOS stack, these interfaces should be used only when you are absolutely certain there is no
way to achieve the same objective using a framework located in a higher iOS layer.
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5. Joining the Apple iOS Developer
Program

T

he first step in the process of learning to develop iOS 5 based iPad applications involves gaining an
understanding of the differences between Registered Apple Developers and iOS Developer Program
Members. Having gained such an understanding, the next choice is to decide the point at which it makes
sense for you to pay to join the iOS Developer Program. With these goals in mind, this chapter will cover the
differences between the two categories of developer, outline the costs and benefits of joining the developer
program and, finally, walk through the steps involved in obtaining each membership level.

5.1 Registered Apple Developer
There is no fee associated with becoming a registered Apple developer. Simply visit the following web page
to begin the registration process:
http://developer.apple.com/programs/register/
An existing Apple ID (used for making iTunes or Apple Store purchases) is usually adequate to complete the
registration process.
Once the registration process is complete, access is provided to developer resources such as online
documentation and tutorials. Registered developers are also able to download older versions of the iOS SDK
and Xcode development environment.
In order to obtain the latest versions of both the iOS SDK and Xcode, registered developers must either
purchase them from the Mac App Store or enroll in the iOS Developer Program. The latest iOS SDK and Xcode
package costs $4.99 to purchase from the Mac App Store and may be found at the following location:
http://itunes.apple.com/us/app/xcode/id422352214?mt=12&ls=1
This raises the question of whether to upgrade to the iOS Developer Program, or to remain as a Registered
Apple Developer and simply purchase the latest iOS SDK and Xcode package. It is important, therefore, to
understand the key benefits of the iOS Developer Program.

5.2 iOS Developer Program
Membership in the iOS Developer Program currently costs $99 per year. As previously mentioned,
membership includes access to the latest versions of the iOS SDK and Xcode development environment. The
benefits of membership, however, go far beyond those offered at the Registered Apple Developer level.
One of the key advantages of the developer program is that it permits the creation of certificates and
provisioning profiles to test applications on physical devices. Although Xcode includes device simulators
which allow for a significant amount of testing to be performed, there are certain areas of functionality, such

19

Joining the Apple iOS Developer Program

as location tracking and device motion, which can only fully be tested on a physical device. Of particular
significance is the fact that iCloud access can only be tested when applications are running on physical
devices.
Of further significance is the fact that iOS Developer Program members have unrestricted access to the full
range of guides and tutorials relating to the latest iOS SDK and, more importantly, have access to technical
support from Apple’s iOS technical support engineers (though the annual fee covers the submission of only
two support incident reports).
By far the most important aspect of the iOS Developer Program is that membership is a mandatory
requirement in order to publish an application for sale or download in the App Store.
Clearly, developer program membership is going to be required at some point before your application
reaches the App Store. The only question remaining is when exactly to sign up.

5.3 When to Enroll in the iOS Developer Program?
Clearly, there are many benefits to iOS Developer Program membership and, eventually, membership will be
necessary to begin selling applications. As to whether or not to pay the enrollment fee now or later will
depend on individual circumstances. If you are still in the early stages of learning to develop iOS applications
or have yet to come up with a compelling idea for an application to develop then much of what you need is
provided by spending the nominal fee to purchase the latest iOS SDK and Xcode bundle. As your skill level
increases and your ideas for applications to develop take shape you can, after all, always enroll in the
developer program at a later date.
If, on the other hand, you are confident that you will reach the stage of having an application ready to publish
or know that you will need to test the functionality of the application on a physical device as opposed to a
simulator then it is worth joining the developer program sooner rather than later.

5.4 Enrolling in the iOS Developer Program
If your goal is to develop iPad applications for your employer then it is first worth checking whether the
company already has membership. That being the case, contact the program administrator in your company
and ask them to send you an invitation from within the iOS Developer Program Member Center to join the
team. Once they have done so, Apple will send you an email entitled You Have Been Invited to Join an Apple
Developer Program containing a link to activate your membership. If you or your company is not already a
program member, you can enroll online at:
http://developer.apple.com/programs/ios/
Apple provides enrollment options for businesses and individuals. To enroll as an individual you will need to
provide credit card information in order to verify your identity. To enroll as a company you must have legal
signature authority (or access to someone who does) and be able to provide documentation such as Articles
of Incorporation and a Business License.
Acceptance into the developer program as an individual member typically takes less than 24 hours with
notification arriving in the form of an activation email from Apple. Enrollment as a company can take
considerably longer (sometimes weeks or even months) due to the burden of the additional verification
requirements.
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Whilst awaiting activation you may log into the Member Center with restricted access using your Apple ID
and password at the following URL:
http://developer.apple.com/membercenter
Once logged in, clicking on the Your Account tab at the top of the page will display the prevailing status of
your application to join the developer program as Enrollment Pending:

Figure 5-1

Once the activation email has arrived, log into the Member Center again and note that access is now
available to a wide range of options and resources as illustrated in Figure 5-2:

Figure 5-2

5.5 Summary
An important early step in iPad iOS 5 application development process involves registering as an Apple
Developer and identifying the best time to upgrade to iOS Developer Program membership. This chapter has
outlined the differences between the two programs, provided some guidance to keep in mind when
considering developer program membership and walked briefly through the enrollment process. The next
step is to download and install the iOS 5 SDK and Xcode development environment.
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Chapter 6
6. Installing Xcode 4 and the iOS 5 SDK

i

Pad apps are developed using the iOS SDK in conjunction with Apple’s Xcode 4 development environment.
The iOS SDK contains the development frameworks that were outlined in iOS 5 Architecture and
Frameworks. Xcode 4 is an integrated development environment (IDE) within which you will code, compile,
test and debug your iOS iPad applications. The Xcode 4 environment also includes a feature called Interface
Builder which enables you to graphically design the user interface of your application using the components
provided by the UIKit framework.
In this chapter we will cover the steps involved in installing both Xcode 4 and the iOS 5 SDK on Mac OS X.

6.1 Identifying if you have an Intel or PowerPC based Mac
Only Intel based Mac OS X systems can be used to develop applications for iOS. If you have an older, PowerPC
based Mac then you will need to purchase a new system before you can begin your iPad app development
project. If you are unsure of the processor type inside your Mac, you can find this information by opening the
Finder and selecting the About This Mac option from the Apple menu. In the resulting dialog check the
Processor line. Figure 6-1 illustrates the results obtained on an Intel based system.

Figure 6-1

If the dialog on your Mac does not reflect the presence of an Intel based processor then your current system
is, sadly, unsuitable as a platform for iPad iOS app development.
In addition, the iOS 5 SDK with Xcode 4.2 environment requires that the version of Mac OS X running on the
system be version 10.6.6 or later. If the “About This Mac” dialog does not indicate that Mac OS X 10.6.6 or

23

Installing Xcode 4 and the iOS 5 SDK

later is running, click on the Software Update… button to download and install the appropriate operating
system upgrades.

6.2 Installing Xcode 4 and the iOS 5 SDK
The best way to obtain the latest versions of Xcode 4 and the iOS SDK is to download them from the Apple
iOS Dev Center web site at:
http://developer.apple.com/devcenter/ios/index.action
In order to download Xcode 4 with the iOS 5 SDK, you will either need to be a member of the iOS Developer
programs or purchase a copy from the Mac App Store at:
http://itunes.apple.com/us/app/xcode/id422352214?mt=12&ls=1
The download is over 3.5GB in size and may take a number of hours to complete depending on the speed of
your internet connection. The package takes the form of a disk image (.dmg) file. Once the download has
completed, a new window will open as follows displaying the contents of the .dmg file:

Figure 6-2

If this window does not open by default, it can be opened by clicking on the SDK disk drive icon on the
desktop or by navigating to the Downloads directory of your home folder and double clicking on the
corresponding dmg file.
Initiate the installation by double clicking on the package icon (the one that looks like an opening box) and
follow the instructions until you reach the Custom Install screen:
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Figure 6-3

The default selections on this screen are adequate for most requirements so unless you have specific needs
there is no necessity to alter these selections. Continue to the next screen, review the information and click
Install to begin the installation. Note that you may first be prompted to enter your password as a security
precaution. The duration of the installation process will vary depending on the speed and current load on the
computer, but typically completes in 25 - 45 minutes.

6.3 Starting Xcode 4
Having successfully installed the SDK and Xcode 4, the next step is to launch it so that we can write and then
create a sample iPad application. To start up Xcode, open the Finder and search for Xcode. Since you will be
making frequent use of this tool take this opportunity to drag and drop it into your dock for easier access in
the future. Click on the Xcode icon in the dock to launch the tool.
Once Xcode has loaded, and assuming this is the first time you have used Xcode on this system, you will be
presented with the Welcome screen from which you are ready to proceed:
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Figure 6-4

Having installed the iOS 5 SDK and successfully launched Xcode 4 we can now look at Creating a Simple iPad
iOS 5 App.

6.4 Summary
Before iPad application development work can begin the first step is to install the iOS 5 SDK and Xcode
development environment onto an Intel based Mac OS X system. In this chapter we have explored the steps
involved in achieving this.
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7. Creating a Simple iPad iOS 5 App

I

t is traditional in books covering programming topics to provide a very simple example early on. This
practice, though still common, has been maligned by some authors of recent books. Those authors,
however, are missing the point of the simple example. One key purpose of such an exercise is to provide a
very simple way to verify that your development environment is correctly installed and fully operational
before moving on to more complex tasks. A secondary objective is to give the reader a quick success very
early in the learning curve to inspire an initial level of confidence. There is very little to be gained by plunging
into complex examples that confuse the reader before having taken time to explain the underlying concepts
of the technology.
With this in mind, iPad iOS 5 Development Essentials will remain true to tradition and provide a very simple
example with which to get started. In doing so, we will also be honoring another time honored tradition by
providing this example in the form of a simple “Hello World” program. The “Hello World” example was first
used in a book called the C Programming Language written by the creators of C, Brian Kernighan and Dennis
Richie. Given that the origins of Objective-C can be traced back to the C programming language it is only
fitting that we use this example for iOS 5 and the iPad.

7.1 Starting Xcode 4
As with all iOS examples in this book, the development of our example will take place within the Xcode 4
development environment. If you have not already installed this tool together with the latest iOS SDK refer
first to the Installing Xcode 4 and the iOS 5 SDK chapter of this book. Assuming that the installation is
complete, launch Xcode either by clicking on the icon on the dock (assuming you created one) or use the
Finder tool to search for Xcode.
When launched for the first time, and until you turn off the Show this window when Xcode launches toggle,
the screen illustrated in Figure 7-1 will appear by default:
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Figure 7-1

If you do not see this window, simply select the Window -> Welcome to Xcode menu option to display it.
From within this window click on the option to Create a new Xcode project. This will display the main Xcode 4
project window together with the New Project panel where we are able to select a template matching the
type of project we want to develop:

Figure 7-2

The panel located on the left hand side of the window allows for the selection of the target platform
providing options to develop an application either for an iOS based device or Mac OS X.
Begin by making sure that the Application option located beneath iOS is selected. The main panel contains a
list of templates available to use as the basis for an application. The options available are as follows:
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Master-Detail Application – Used to create a list based application. Selecting an item from a master list
displays a detail view corresponding to the selection. The template then provides a Back button to return
to the list. You may have seen a similar technique used for news based applications, whereby selecting
an item from a list of headlines displays the content of the corresponding news article. When used for an
iPad based application this template implements a basic split-view configuration.
OpenGL Game – As discussed in iOS 5 Architecture and SDK Frameworks, the OpenGL ES framework
provides an API for developing advanced graphics drawing and animation capabilities. The OpenGL ES
Game template creates a basic application containing an OpenGL ES view upon which to draw and
manipulate graphics and a timer object.
Page-based Application – Creates a template project using the page view controller designed to allow
views to be transitioned by turning pages on the screen.
Tabbed Application – Creates a template application with a tab bar. The tab bar typically appears across
the bottom of the device display and can be programmed to contain items that, when selected, change
the main display to different views. The iPhone’s built-in Phone user interface, for example, uses a tab
bar to allow the user to move between favorites, contacts, keypad and voicemail.
Utility Application – Creates a template consisting of a two sided view. For an example of a utility
application in action, load up the standard iPhone weather application. Pressing the blue info button flips
the view to the configuration page. Selecting Done rotates the view back to the main screen.
Single View Application – Creates a basic template for an application containing a single view and
corresponding view controller.
Empty Application – The most basic of templates this creates only a window and a delegate. If none of
the above templates match your requirements then this is the option to take.

For the purposes of our simple example, we are going to use the Single View Application template so select
this option from the new project window and click Next to configure some project options:

Figure 7-3
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On this screen, enter a Product name for the application that is going to be created, in this case “HelloWorld”
and make sure that the class prefix matches this name. The company identifier is typically the reversed URL
of your company’s website, for example “com.mycompany”. This will be used when creating provisioning
profiles and certificates to enable applications to be tested on a physical iPad device (covered in more detail
in Testing iOS 5 Apps on the iPad – Developer Certificates and Provisioning Profiles). Enter the Class Prefix
value of “HelloWorld” which will be used to prefix any classes created for us by Xcode when the template
project is created.
Make sure that iPad is currently selected from the Device Family menu and that neither the Use Storyboard
nor the Include Unit Tests options are currently selected.
Automatic Reference Counting is a new feature included with the Objective-C compiler which removes much
of the responsibility from the developer for releasing objects when they are no longer needed. This is an
extremely useful new feature and, as such, the option should be selected before clicking the Next button to
proceed. On the final screen, choose a location on the file system for the new project to be created can click
on Create.
Once the new project has been created the main Xcode window will appear as illustrated in Figure 7-4:

Figure 7-4

Before proceeding we should take some time to look at what Xcode has done for us. Firstly it has created a
group of files that we will need to create our application. Some of these are Objective-C source code files
(with a .m extension) where we will enter the code to make our application work, others are header or
interface files (.h) that are included by the source files and are where we will also need to put our own
declarations and definitions. In addition, the .xib file is the save file used by the Interface Builder tool to hold
the user interface design we will create. Older versions of Interface Builder saved designs in files with a .nib
extension so these files, even today, are called NIB files. Also present will be one or more files with a .plist file
extension. These are Property List files which contain key/value pair information. For example, the
HelloWorld-info.plist file contains resource settings relating to items such as the language, icon file,
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executable name and app identifier. The list of files is displayed in the Project Navigator located in the left
hand panel of the main Xcode project window. A toolbar at the top of this panel contains build and run
status, breakpoints, scheme selections and a range of settings to configure the panels displayed by Xcode.
By default, the center panel of the window shows a summary of the settings for the application. This includes
the identifier specified during the project creation process and the target device. Options are also provided to
configure the orientations of the device that are to be supported by the application together with options to
upload an icon (the small image the user selects on the device screen to launch the application) and splash
screen image (displayed to the user while the application loads) for the application.
In addition to the Summary screen, tabs are provided to view and modify additional settings consisting of
Info, Build Settings, Build Phases and Build Rules. As we progress through subsequent chapters of this book
we will explore some of these other configuration options in greater detail. To return to the Summary panel
at any future point in time, make sure the Project Navigator is selected in the left hand panel and select the
top item (the application name) in the navigator list.
When a source file is selected from the list in the navigator panel, the contents of that file will appear in the
center panel where it may then be edited. To open the file in a separate editing window, simply double click
on the file in the list.

7.2 Creating the iOS App User Interface
Simply by the very nature of the environment in which they run, iPad apps are typically visually oriented. As
such, a key component of just about any app involves a user interface through which the user will interact
with the application and, in turn, receive feedback. Whilst it is possible to develop user interfaces by writing
code to create and position items on the screen, this is a complex and error prone process. In recognition of
this, Apple provides a tool called Interface Builder which allows a user interface to be visually constructed by
dragging and dropping components onto a canvas and setting properties to configure the appearance and
behavior of those components. Interface Builder was originally developed some time ago for creating Mac OS
X applications, but has now been updated to allow for the design of iOS app user interfaces.
As mentioned in the preceding section, Xcode pre-created a number of files for our project, one of which has
a .xib filename extension. This is an Interface Builder save file (remember that they are called NIB files, not
XIB files). The file we are interested in for our HelloWorld project is called HelloWorldViewController.xib. To
load this file into Interface Builder simply select the file name in the list in the left hand panel. Interface
Builder will subsequently appear in the center panel as shown in Figure 7-5:
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Figure 7-5

In the center panel a visual representation of the user interface of the application is displayed. Initially this
consists solely of the UIView object. This UIView object was added to our design by Xcode when we selected
the Single View Application option during the project creation phase. We will construct the user interface for
our HelloWorld app by dragging and dropping user interface objects onto this UIView object. Designing a
user interface consists primarily of dragging and dropping visual components onto the canvas and setting a
range of properties and settings. In order to access objects and property settings it is necessary to display the
Xcode right hand panel. This is achieved by selecting the right hand button in the View section of the Xcode
toolbar:

Figure 7-6

The right hand panel, once displayed, will appear as illustrated in Figure 7-7:
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Figure 7-7

Along the top edge of the panel is a row of buttons which change the settings displayed in the upper half of
the panel. By default the File Inspector is displayed. Options are also provided to display quick help, the
Identity Inspector, Attributes Inspector, Size Inspector and Connections Inspector. Before proceeding, take
some time to review each of these selections to gain some familiarity with the configuration options each
provides. Throughout the remainder of this book extensive use of these inspectors will be made.
The lower section of the panel defaults to displaying the file template library. Above this panel is another
toolbar containing buttons to display other categories. Options include frequently used code snippets to save
on typing when writing code, the object library and the media library. For the purposes of this tutorial we
need to display the object library so click in the appropriate toolbar button (the three dimensional cube). This
will display the UI components that can be used to construct our user interface. Move the cursor to the line
above the lower toolbar and click and drag to increase the amount of space available for the library if
required. In addition, the objects are categorized into groups which may be selected using the menu beneath
the toolbar. The layout buttons may also be used to switch from a single column of objects with descriptions
to multiple columns without descriptions.

7.3 Changing Component Properties
With the property panel for the View selected in the main panel, we will begin our design work by changing
the background color of this view. Begin by making sure the View is selected and that the Attribute Inspector
(View -> Utilities -> Show Attribute Inspector) is displayed in the right hand panel. Click on the gray rectangle
next to the Background label to invoke the Colors dialog. Using the color selection tool, choose a visually
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pleasing color and close the dialog. You will now notice that the view window has changed from gray to the
new color selection.

7.4 Adding Objects to the User Interface
The next step is to add a Label object to our view. To achieve this, select Cocoa Touch -> Controls from the
library panel menu, click on the Label object and drag it to the center of the view. Once it is in position
release the mouse button to drop it at that location:

Figure 7-8

Using the blue markers surrounding the label border, stretch first the left and then right side of the label out
to the edge of the view until the vertical blue dotted lines marking the recommended border of the view
appear. With the Label still selected, click on the centered alignment button in the Layout attribute section of
the Attribute Inspector (View -> Utilities -> Show Attribute Inspector) to center the text in the middle of the
screen. Click on the current font attribute setting to choose a larger font setting, for example a Georgia bold
typeface with a size of 24.
Finally, double click on the text in the label that currently reads “Label” and type in “Hello World”. At this
point, your View window will hopefully appear as outlined in Figure 7-9 (allowing, of course, for differences in
your color and font choices):
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Figure 7-9

Having created our simple user interface design we now need to save it. To achieve this, select File -> Save or
use the Command+S keyboard shortcut.

7.5 Building and Running an iOS App in Xcode 4
Before an app can be run it must first be compiled. Once successfully compiled it may be run either within a
simulator or on a physical iPhone, iPad or iPod Touch device. The process for testing an app on a physical
device requires some additional steps to be performed involving developer certificates and provisioning
profiles and will be covered in detail in Testing iOS 5 Apps on the iPad – Developer Certificates and
Provisioning Profiles. For the purposes of this chapter, however, it is sufficient to run the app in the simulator.
Within the main Xcode 4 project window make sure that the menu located in the top left hand corner of the
window (to the right of the Stop button) has the iPad Simulator option selected and then click on the Run
toolbar button to compile the code and run the app in the simulator. The small iTunes style window in the
center of the Xcode toolbar will report the progress of the build process together with any problems or errors
that cause the build process to fail. Once the app is built, the simulator will start and the HelloWorld app will
run:
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Figure 7-10

7.6 Dealing with Build Errors
As we have not actually written or modified any code in this chapter it is unlikely that any errors will be
detected during the build and run process. In the unlikely event that something did get inadvertently
changed thereby causing the build to fail it is worth taking a few minutes to talk about build errors within the
context of the Xcode environment.
If for any reason a build fails, the status window in the Xcode 4 toolbar will report that an error has been
detected by displaying “Build” together with the number of errors detected and any warnings. In addition,
the left hand panel of the Xcode window will update with a list of the errors. Selecting an error from this list
will take you to the location in the code where corrective action needs to be taken.

7.7 Summary
A simple example is a good way to verify that the development environment is correctly installed and
operational. It also provides an early level of confidence that a more complex example would fail to provide.
In this chapter we have created a very simple iPad iOS 5 application consisting of a colored background a
label object.
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8. Testing iOS 5 Apps on the iPad –
Developer Certificates and Provisioning
Profiles

I

n the chapter entitled Creating a Simple iPad iOS 5 App we used the iOS Simulator bundled with the iOS 5
SDK to test an example application. Whilst this is fine for most cases, in practice there are a number of
areas that cannot be comprehensively tested in the simulator. For example, no matter how hard you shake
your computer (not something we actually recommend) or where in the world you move it to, neither the
accelerometer nor GPS features will provide real world results within the simulator (though the simulator
does have the option to perform a basic virtual shake gesture and to simulate location data). If we really want
to test an iOS application thoroughly in the real world, therefore, we need to install the app onto a physical
iPad device.
In order to achieve this a number of steps are required. These include generating and installing a developer
certificate, creating an App ID and provisioning profile for your application, and registering the devices onto
which you wish to directly install your apps for testing purposes. In the remainder of this chapter we will
cover these steps in detail.
Note that the provisioning of physical devices requires membership in the iOS Developer Program, a topic
covered in some detail in the chapter entitled Joining the Apple iOS Developer Program.

8.1 Creating an iOS Development Certificate Signing Request
Any apps that are to be installed on a physical iPad device must first be signed using an iOS Development
Certificate. In order to generate a certificate the first step is to generate a Certificate Signing Request (CSR).
Begin this process by opening the Keychain Access tool on your Mac system. This tool is located in the
Applications -> Utilities folder. Once launched, the Keychain Access main window will appear as illustrated in
Figure 8-1:
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Figure 8-1

Within the Keychain Access utility, perform the following steps:
1. Select the Keychain Access -> Preferences menu and select Certificates in the resulting dialog.

Figure 8-2

2. Within the Preferences dialog make sure that the Online Certificate Status Protocol (OCPS) and
Certificate Revocation List (CRL) settings are both set to Off, then close the dialog.
3. Select the Keychain Access -> Certificate Assistant -> Request Certificate from a Certificate Authority…
menu option and enter your email and name exactly as registered with the iOS Developer Program.
Leave the CA Email Address field blank and select the Saved to Disk and Let me specify key pair
information options:
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Figure 8-3

4. Clicking the Continue button will prompt for a file and location into which the CSR is to be saved. Either
accept the default settings, or enter alternative information as desired at which point the Key Pair
Information screen will appear as illustrated in Figure 8-4:

Figure 8-4

5. Verify that the 2048 bits key size and RSA algorithm options are selected before clicking on the Continue
button. The certificate request will be created in the file previously specified and the Conclusion screen
displayed. Click Done to dismiss the Certificate Assistant window.
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8.2 Submitting the iOS Development Certificate Signing Request
Having created the Certificate Signing Request (CSR) the next step is to submit it for approval. This is
performed within the iOS Provisioning Portal that is accessed from the Member Center of the Apple
developer web site. Under Developer Program Resources on the main member center home page select iOS
Provisioning Portal. Within the portal, select the Certificates link located in the left hand panel to display the
Certificates page:

Figure 8-5

Click on the Request a Certificate button, scroll down to the bottom of the text under the heading Create an
iOS Development Certificate and click on the Choose File button. In the resulting file selection panel, navigate
to the certificate signing request file created in the previous section and click on Choose. Once your file
selection is displayed next to the Choose File button, click on the Submit button located in the bottom right
hand corner of the web page. At this point you will be returned to the main Certificates page where your
certificate will be listed as Pending Issuance.
Click on the link to download the WWDR intermediate certificate and, once downloaded, double click on it to
install it into the keychain. This certificate is used by Xcode to verify that your certificates are both valid and
issued by Apple.
If you are not the Team Administrator, you will need to wait until that person approves your request. If, on
the other hand, you are the administrator for the iOS Developer Program membership you may approve your
own certificate request by clicking on the Approve button located in the Action column of the Current
Certificates table. If no approval button is present simply refresh the web page and the certificate should
automatically appear listed as Issued. Your certificate is now active and the table will have refreshed to
include a button to Download the certificate:
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Figure 8-6

8.3 Installing an iOS Development Certificate
Once a certificate has been requested and issued it must be installed on the development system so that
Xcode can access it and use it to sign any applications you develop. The first step in this process is to
download the certificate from the iOS Provisioning Portal by clicking on the Download button located on the
Certificates page outlined in the previous section. Once the file has downloaded, double click on it to load it
into the Keychain Access tool. The certificate will then be listed together with a status (hopefully one that
reads This certificate is valid):

Figure 8-7

Your certificate is now installed into your Keychain and you are ready to move on to the next step.

41

Testing iOS 5 Apps on the iPad – Developer Certificates and Provisioning Profiles

8.4 Assigning Devices
Once you have a development certificate installed, the next step is to specify which devices are to be used to
test the iOS apps you are developing. This is achieved by entering the Unique Device Identifier (UDID) for
each device into the Provisioning Portal. Note that Apple restricts developers to 100 provisioned devices per
year.
A new device may be added to the list of supported test devices either from within the Xcode Organizer
window, or by logging into the iOS Developer Portal and manually adding the device. To add a device to the
portal from within Organizer, simply connect the device, open the Organizer window in Xcode using the
Organizer toolbar button, select the attached device from the left hand panel and click on the Add to Portal
button. The Organizer will prompt for the developer portal login and password before connecting and
enabling the device for testing.
Manually adding a device, on the other hand, requires the use of the iPad’s UDID. This may be obtained
either via Xcode or iTunes. Begin by connecting the device to your computer using the docking connector.
Once Xcode has launched the Organizer window will appear displaying summary information about the
device (or may be opened by selecting the Organizer button in the Xcode toolbar). The UDID is listed next to
the Identifier label as illustrated in Figure 8-8:

Figure 8-8

Alternatively, launch iTunes, select the device in the left hand pane and review the Summary information
page. One of the fields on this page will be labeled as Serial Number. Click with the mouse on this number
and it will change to display the UDID.
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Having identified the UDIDs of any devices you plan to use for app testing, select the Devices link located in
the left hand panel of the iOS Provisioning Portal, and click on Add Devices in the resulting page. On the Add
Devices page enter a descriptive name for the device and the 40 character UDID:

Figure 8-9

In order to add more than one device at a time simply click on the “+” button to create more input fields.
Once you have finished adding devices click on the Submit button. The newly added devices will now appear
on the main Devices page of the portal.

8.5 Creating an App ID
The next step in the process is to create an App ID for each app that you create. This ID allows your app to be
uniquely identified within the context of the Apple iOS ecosystem. To create an App ID, select the App IDs link
in the provisioning portal and click on the New App ID button to display the Create App ID screen as
illustrated in Figure 8-10:

Figure 8-10

Enter a suitably descriptive name into the Description field and then make a Bundle Seed ID selection. If you
have not created any previous Seed IDs then leave the default Generate New selection unchanged. If you

43

Testing iOS 5 Apps on the iPad – Developer Certificates and Provisioning Profiles

have created a previous App ID and would like to use this for your new app, click on the menu and select the
desired ID from the drop down list. Finally enter the Bundle Identifier. This is typically set to the reversed
domain name of your company followed by the name of the app. For example, if you are developing an app
called MyApp, and the URL for your company is www.mycompany.com then your Bundle identifier would be
entered as:
com.mycompany.MyApp

If you would like to create an App ID that can be used for multiple apps then the wildcard character (*) can
be substituted for the app name. For example:
com.mycompany.*

Having entered the required information, click on the Submit button to return to the main App ID page where
the new ID will be listed.

8.6 Creating an iOS Development Provisioning Profile
The Provisioning Profile is where much of what we have created so far in the chapter is pulled together. The
provisioning profile defines which developer certificates are allowed to install an application on a device,
which devices can be used and which applications can be installed. Once created, the provisioning profile
must be installed on each device on which the designated application is to be installed.
To create a provisioning profile, select the Provisioning link in the Provisioning Portal and click on the New
profile button. In the resulting provisioning profile creation screen, perform the following tasks:
1. In the Profile Name field enter a suitably descriptive name for the profile you are creating.
2. Set the check box next to each certificate to specify which developers are permitted to use this particular
profile.
3. Select an App ID from the menu.
4. Select the devices onto which the app is permitted to be installed.
5. Click on the Submit button.
Initially the profile will be listed as Pending. Refresh the page to see the status change to Active.
Now that the provisioning profile has been created, the next step is to download and install it. To do so, click
on the Download button next to your new profile and save it to your local system (note that the file will have
a .mobileprovision file name extension). Once saved, either drag and drop the file onto the Xcode icon in the
dock or onto the Provisioning Profiles item located under Library in the Xcode Organizer window. Once the
provisioning profile is installed, it should appear in the Organizer window (Figure 8-11):
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Figure 8-11

8.7 Enabling an iPad Device for Development
With the provisioning profile installed select the target device in the left hand panel of the Organizer window
and click on the Use for Development button. The Organizer will then prompt you for your Apple developer
login and password.
Once a valid login and password have been entered, the Organizer will perform the steps necessary to install
the provisioning profile on the device and enable it for application testing.

8.8 Associating an App ID with an App
Before we can install our own app directly onto a device, we must first embed the App ID created in the iOS
Provisioning Portal and referenced in the provisioning profile into the app itself. To achieve this:
1. In the left hand panel of the main Xcode window, select the project navigator toolbar button and select
the top item (the application name) from the resulting list.
2. Select the Info tab from in the center panel:
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Figure 8-12

In the Bundle Identifier field enter the App ID you created in the iOS Provisioning Portal. This can either be in
the form of your reverse URL and app name (for example com.mycompany.HelloWorld) or you can have the
product name substituted for you by entering com.mycompany.${PRODUCT_NAME :rfc1034indentifer} as
illustrated in Figure 8-12.
Once the App ID has been configured the next step is to build the application and install it onto the iPad
device.

8.9 iOS and SDK Version Compatibility
Before attempting to install and run an application on a physical iPad device it is important to be aware of
issues relating to version compatibility between the SDK used for the development and the operating system
running on the target device. For example, if the application was developed using version 4.3 of the iOS SDK
then it is important that the iPad on which the app is to be installed is running iOS version 4.3 or later. An
attempt to run the app on an iPad with an older version of iOS will result in an error reported by Xcode that
reads “Xcode cannot run using the selected device. No Provisioned iOS devices are available. Connect an iOS
device or choose an iOS simulator as the destination”.
The absence in this message of any indication that the connected device simply has the wrong version of iOS
installed on it may lead the developer to assume that a problem exists either with the connection or with the
certification or provisioning profile. If you encounter this error message, therefore, it is worth checking
version compatibility before investing what typically turns into many hours of effort trying to resolve nonexistent connectivity and provisioning problems.

8.10 Installing an App onto a Device
Located in the top left hand corner of the main Xcode window is drop down menu which, when clicked,
provides a menu of options to control the target run environment for the current app.
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If either the iPhone or iPad simulator option is selected then the app will run within the corresponding
simulated environment when it is built. To instruct Xcode to install and run the app on the device itself,
simply change this menu to the iOS Device setting. Assuming the device is connected, click on the Run button
and watch the status updates as Xcode compiles and links the source code. Once the code is built, Xcode will
need to sign the application binary using your developer certificate. If prompted with a message that reads
“codesign wants to sign using key “<key name>” in your keychain”, select either Allow or Always Allow (if you
do not wish to be prompted during future builds). Once signing is complete the status will change to
“Installing <appname>.app on iPad…”. After a few seconds the app will be installed and will automatically
start running on the device where it may be tested in a real world environment.

8.11 Summary
Whilst it is possible to perform a wide variety of tests using the iOS Simulator environment, there are a
number of areas of device functionality that can only be fully tested on a physical iPad device. The goal of this
chapter, therefore, has been to outline the steps necessary to perform device-based application testing.
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9. The Basics of Objective-C Programming

I

n order to develop iOS apps for the iPad it is necessary to use a programming language called Objective-C.
A comprehensive guide to programming in Objective-C is beyond the scope of this book. In fact, if you are
unfamiliar with Objective-C programming we strongly recommend that you read a copy of a book called
Objective-C 2.0 Essentials. This is the companion book to iPad iOS 5 Development Essentials and will teach
you everything you need to know about programming in Objective-C.
In the next two chapters we will take some time to go over the fundamentals of Objective-C programming
with the goal of providing enough information to get you started.

9.1 Objective-C Data Types and Variables
One of the fundamentals of any program involves data, and programming languages such as Objective-C
define a set of data types that allow us to work with data in a format we understand when writing a
computer program. For example, if we want to store a number in an Objective-C program we could do so
with syntax similar to the following:
int mynumber = 10;

In the above example, we have created a variable named mynumber of data type integer by using the
keyword int. We then assigned the value of 10 to this variable.
Objective-C supports a variety of data types including int, char, float, double, boolean (BOOL) and a special
general purpose data type named id.
Data type qualifiers are also supported in the form of long, long long, short, unsigned and signed. For
example if we want to be able to store an extremely large number in our mynumber declaration we can
qualify it as follows:
long long int mynumber =

345730489;

A variable may be declared as constant (i.e. the value assigned to the variable cannot be changed subsequent
to the initial assignment) through the use of the const qualifier:
const char myconst = ‘c’;

9.2 Objective-C Expressions
Now that we have looked at variables and data types we need to look at how we work with this data in an
application. The primary method for working with data is in the form of expressions.
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The most basic expression consists of an operator, two operands and an assignment. The following is an
example of an expression:
int myresult = 1 + 2;

In the above example the (+) operator is used to add two operands (1 and 2) together. The assignment
operator (=) subsequently assigns the result of the addition to an integer variable named myresult. The
operands could just have easily been variables (or a mixture of constants and variables) instead of the actual
numerical values used in the example.
In the above example we looked at the addition operator. Objective-C also supports the following arithmetic
operators:
Operator

Description

-(unary)
*
/
+
-

Negates the value of a variable or expression
Multiplication
Division
Addition
Subtraction

%

Modulo

Another useful type of operator is the compound assignment operator. This allows an operation and
assignment to be performed with a single operator. For example one might write an expression as follows:
x = x + y;

The above expression adds the value contained in variable x to the value contained in variable y and stores
the result in variable x. This can be simplified using the addition compound assignment operator:
x += y

Objective-C supports the following compound assignment operators:
Operator

Description

x += y
x -= y
x *= y

Add x to y and place result in x

x /= y
x %= y
x &= y
x |= y
x ^= y

Divide x by y and place result in x
Perform Modulo on x and y and place result in x
Assign to x the result of logical AND operation on x and y
Assign to x the result of logical OR operation on x and y
Assign to x the result of logical Exclusive OR on x and y

Subtract y from x and place result in x
Multiply x by y and place result in x

Another useful shortcut can be achieved using the Objective-C increment and decrement operators (also
referred to as unary operators because they operate on a single operand). As with the compound assignment
operators described in the previous section, consider the following Objective-C code fragment:
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x = x + 1; // Increase value of variable x by 1
x = x - 1; // Decrease value of variable x by 1

These expressions increment and decrement the value of x by 1. Instead of using this approach it is quicker to
use the ++ and -- operators. The following examples perform exactly the same tasks as the examples above:
x++; Increment x by 1
x--; Decrement x by 1

These operators can be placed either before or after the variable name. If the operator is placed before the
variable name the increment or decrement is performed before any other operations are performed on the
variable.
In addition to mathematical and assignment operators, Objective-C also includes a set of logical operators
useful for performing comparisons. These operators all return a Boolean (BOOL) true (1) or false (0) result
depending on the result of the comparison. These operators are binary operators in that they work with two
operands.
Comparison operators are most frequently used in constructing program flow control logic. For example
an if statement may be constructed based on whether one value matches another:
if (x == y)
// Perform task

The result of a comparison may also be stored in a BOOL variable. For example, the following code will result
in a true (1) value being stored in the variable result:
BOOL result;
int x = 10;
int y = 20;
result = x < y;

Clearly 10 is less than 20, resulting in a true evaluation of the x < y expression. The following table lists the full
set of Objective-C comparison operators:
Operator

Description

x == y
x>y
x >= y
x<y
x <= y
x != y

Returns true if x is equal to y
Returns true if x is greater than y
Returns true if x is greater than or equal to y
Returns true if x is less than y
Returns true if x is less than or equal to y
Returns true if x is not equal to y

Objective-C also provides a set of so called logical operators designed to return boolean true and false. In
practice true equates to 1 and false equates to 0. These operators both return boolean results and take
boolean values as operands. The key operators are NOT (!), AND (&&), OR (||) and XOR (^).
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The NOT (!) operator simply inverts the current value of a boolean variable, or the result of an expression. For
example, if a variable named flag is currently 1 (true), prefixing the variable with a '!' character will invert the
value to 0 (false):
bool flag = true; //variable is true
bool secondFlag;
secondFlag = !flag; // secondFlag set to false

The OR (||) operator returns 1 if one of its two operands evaluates to true, otherwise it returns 0. For
example, the following example evaluates to true because at least one of the expressions either side of the
OR operator is true:
if ((10 < 20) || (20 < 10))
NSLog (@"Expression is true");

The AND (&&) operator returns 1 only if both operands evaluate to be true. The following example will return
0 because only one of the two operand expressions evaluates to true:
if ((10 < 20) && (20 < 10))
NSLog (@"Expression is true");

The XOR (^) operator returns 1 if one and only one of the two operands evaluates to true. For example, the
following example will return 1 since only one operator evaluates to be true:
if ((10 < 20) ^ (20 < 10))
System.Console.WriteLine("Expression is true");

If both operands evaluated to true or both were false the expression would return false.
Objective-C uses something called a ternary operator to provide a shortcut way of making decisions. The
syntax of the ternary operator (also known as the conditional operator) is as follows:
[condition] ? [true expression] : [false expression]

The way this works is that [condition] is replaced with an expression that will return either true (1) or false (0).
If the result is true then the expression that replaces the [true expression] is evaluated. Conversely, if the
result was false then the [false expression] is evaluated. Let's see this in action:
int x = 10;
int y = 20;
NSLog(@"Largest number is %i", x > y ? x : y );

The above code example will evaluate whether x is greater than y. Clearly this will evaluate to false resulting
in y being returned to the NSLog call for display to the user:
2009-10-07 11:14:06.756 t[5724] Largest number is 20

9.3 Objective-C Flow Control with if and else
Since programming is largely an exercise in applying logic, much of the art of programming involves writing
code that makes decisions based on one or more criteria. Such decisions define which code gets executed
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and, conversely, which code gets by-passed when the program is executing. This is often referred to as flow
control since it controls the flow of program execution.
The if statement is perhaps the most basic of flow control options available to the Objective-C programmer.
The basic syntax of the Objective-C if statement is as follows:
if (boolean expression) {
// Objective-C code to be performed when expression evaluates to true
}

Note that the braces ({}) are only required if more than one line of code is executed after the if expression. If
only one line of code is listed under the if the braces are optional. For example, the following is valid code:
int x = 10;
if (x > 10)
x = 10;

The next variation of the if statement allows us to also specify some code to perform if the expression in the
if statement evaluates to false. The syntax for this construct is as follows:
if (boolean expression) {
// Code to be executed if expression is true
} else {
// Code to be executed if expression is false
}

Using the above syntax, we can now extend our previous example to display a different message if the
comparison expression evaluates to be false:
int x = 10;
if ( x > 9 )
{
NSLog (@"x is greater than 9!");
} else {
NSLog (@"x is less than 9!");
}

In this case, the second NSLog statement would execute if the value of x was less than 9.
So far we have looked at if statements which make decisions based on the result of a single logical
expression. Sometimes it becomes necessary to make decisions based on a number of different criteria. For
this purpose we can use the if ... else if ... construct, the syntax for which is as follows:
int x = 9;
if (x == 10)
{
NSLog (@"x is 10");
}
else if (x == 9)
{
NSLog (@"x is 9");
}
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else if (x == 8)
{
NSLog (@"x is 8");
}

9.4 Looping with the for Statement
The syntax of an Objective-C for loop is as follows:
for ( ''initializer''; ''conditional expression''; ''loop expression'' )
{
// statements to be executed
}

The initializer typically initializes a counter variable. Traditionally the variable name i is used for this purpose,
though any valid variable name will do. For example:
i = 0;

This sets the counter to be the variable i and sets it to zero. Note that the current widely used Objective-C
standard (c89) requires that this variable be declared prior to its use in the for loop. For example:
int i=0;
for (i = 0; i < 100; i++)
{
// Statements here
}

The next standard (c99) allows the variable to be declared and initialized in the for loop as follows:
for (int i=0; i<100; i++)
{
//Statements here
}

It is possible to break out of a for loop before the designated number of iterations have been completed
using the break; statement.

9.5 Objective-C Looping with do and while
The Objective-C for loop described previously works well when you know in advance how many times a
particular task needs to be repeated in a program. There will, however, be instances where code needs to be
repeated until a certain condition is met, with no way of knowing in advance how many repetitions are going
to be needed to meet that criteria. To address this need, Objective-C provides the while loop.
The while loop syntax is defined follows:
while (''condition'')
{
// Objective-C statements go here
}
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9.6 Objective-C do ... while loops
It is often helpful to think of the do ... while loop as an inverted while loop. The while loop evaluates an
expression before executing the code contained in the body of the loop. If the expression evaluates to false
on the first check then the code is not executed. The do ... while loop, on the other hand, is provided for
situations where you know that the code contained in the body of the loop will always need to be executed
at least once.
The syntax of the do ... while loop is as follows:
do
{
// Objective-C statements here
} while (''conditional expression'')

9.7 Summary
In this chapter we have covered the basic data types, constructs and flow control logic that comprise the
Objective-C programming language.
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